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Microsoft Excel 
 คือโปรแกรมที่เหมาะกับงานดานการคํานวณ การตีตาราง การหาคาสตูรตางๆ การสรางกราฟ 

โดยที่เมื่อเปล่ียนแปลงตวัเลขใดๆ โปรแกรมจะทาํการคํานวณสูตรที่เชือ่มโยงกับตัวเลขนั้นๆใหอัตโนมัติ 

ในการทํางานของโปรแกรมจะใชตารางตามแนวตั้ง (columns) และแนวนอน (rows) เปนหลัก  

 

การเรียกใชโปรแกรม Microsoft Excel 

 
 
เลือกที่ 1. Start > 2. All Programs > 3. Microsoft Office > 4. Microsoft Office Excel 2003 

 

 

 

 



หนาตาโปรแกรม 

 
 

1. แถบชื่อเร่ือง (Title Bar) ชื่อโปรแกรมและชื่อไฟล 

2. แถบเมน ู(Menu Bar) ชื่อเมนูที่เรียกใชได 

3. แถบเครื่องมือ (Tool Bar) แสดงคําสั่งที่ใชงานบอย ๆ แสดงในรูปของรูปภาพ (icon) 

4. แถบสูตร (Formula Bar) สําหรับใสสูตรเพือ่คํานวณ และแสดงเนื้อหาขอมูลในแตละ Cell 

5. เร่ิมตน (Getting Started) หนาตางอํานวยความสะดวกในการเริ่มตนใชงานโปรแกรม 

6. แถบสถานะ (Status Bar) แสดงการใชงานเอกสารในขณะนั้น 

 

 

 

 

 

 

 



แถบเครื่องมือมาตรฐาน (Standard) 

 
 

ปุม ช่ือปุม หนาที ่

 
New (สราง) เปดเอกสารชุดใหม 

 
Open (เปด) เรียกเอกสารชุดเกาที่เก็บบันทึกไวมาใช 

 
Save (บันทึก) ส่ังเก็บบันทึกเอกสาร 

 
Permission (สิทธิ) การจัดการสิทธิ์ในการใชขอมูล 

 

 

E-mail 

(as Attachment) 

(อีเมล(ตามใบแนบ)) 

เปดโปแกรมสรางอีเมล พรอมแนบไฟลของ Word ไปดวย 

 
Print (พิมพ) ส่ังพิมพเอกสารลงบนกระดาษ 

 
Print Preview  

(ตัวอยางกอนพิมพ) 

แสดงผลการพิมพบนหนาจอเพื่อดูกอนพิมพจริง 

 
Spelling (การสะกด) ตรวจสอบการสะกดคําตามพจนนุกรม 

 
Research (การวิจัย) ใหขอมูลอางอิงสําหรับงานวิจัย 

 
Cut (ตัด) ลบขอความหรือออบเจ็คที่เลือกไวไปไวในคลิปบอรด 

 
Copy (คัดลอก) คัดลอกขอความหรือออบเจ็คที่เลือกไวไปไวในคลิปบอรด 

 
Past (วาง) นําขอความหรือออบเจ็คมาวางในเอกสารตรงที่ตองการ 

 
Format Painter  

(ตัวคัดวางรูปแบบ) 

คัดลอกรูปแบบขอความหนึ่งไปใสใหกับอีกขอความ 

 
Undo (เลิกทํา) ยกเลิกคําส่ังหรือการทํางานที่ทําลาสุด 

 
Redo (ทําอีกครั้ง) เรียกทําคําส่ังหรือการทํางานที่ถูกยกเลิกไป 

 
Hyperlink  

(การเชื่อมโยงหลายมิติ) 

สรางการเชื่อมโยงจากตําแหนง ที่กําหนดไวไปยังเอกสาร หรือไป

ยังสวนอื่นในเอกสารเดียวกัน หรือURL 

 
Table & Border (ตาราง

และเสนขอบ) 

แสดง/ไมแสดงแถบเครื่องมือตารางและเสนขอบ 

 
Insert Table  

(แทรกตาราง) 

ใสตารางในเอกสาร 



ปุม ช่ือปุม หนาที ่

 
Insert Microsoft Excel 

Worksheet (แทรกแผน 

งาน) 

แทรกสเปรดชีทของโปรแกรม Microsoft Excel 

 
Columns (คอลัมน) จัดขอความเปนหลายคอลัมนเหมือนหนังสือพิมพ 

 

 
Drawing (รูปวาด) เปด/ปด แถบเครื่องมือรูปวาด 

 
Document Map  

(แมปเอกสาร) 

เปด/ปด แผนที่เอกสาร 

 
Show/Hide (ซอน/แสดง) ซอนหรือแสดงสัญลักษณพิเศษ ซึ่งจะไมถูกพิมพออกมา 

 
Zoom (ยอย/ขยาย) ยอหรือขยายเอกสารที่แสดงบนหนาจอตามเปอรเซ็นตที่เลือก 

 
Office Assistant  

(วิธีใช Microsoft Word) 

แสดงOfficeAssistant ซึ่งเปนตัวการตูนที่ใหคําแนะนําในการใช

งาน 

 
Read  

(มุมมองเคาโครงการอาน) 

เปล่ียนเคาโครงของหนากระดาษ และปรับปรุงการแสดงผลของ

ตัวอักษรเพื่อทําใหผานขอมูลไดสะดวกขึ้น เหมาะกับ 

หนากระดาษ ที่มีขอความยาวๆ แตจะไมเหมาะกับพวกกราฟก 

หรือตาราง 

 
แถบเครื่องมือ จัดรูปแบบ (Formatting) 

 
 

ปุม ช่ือปุม หนาที ่

 
Styles and Format 

(ลักษณะและรูปแบบ) 

เปดทาสกเพน (Styles and Formatting) 

 
Style (ลักษณะ) แสดงหรือใชเลือก Style (รูปแบบ) ของขอความตรงที่ 

เคอรเซอรอยู 

 
Font (แบบอักษร) แสดงหรือเลือกแบบของตัวอักษรตรงที่เคอรเซอรอยู 

 
Font Size  

(ขนาดแบบอักษร)   

แสดงหรือใชเลือกขนาดของตัวอักษรที่เคอรเซอรอยู 

 

 
Bold (ตัวหนา) ทําเปนตัวหนาหรือยกเลิก 



ปุม ช่ือปุม หนาที่ 

 
Italic (ตัวเอียง) ทําเปนตัวเอียงหรือยกเลิก 

 
Underline (ขีดเสนใต) ขีดเสนใตหรือยกเลิก 

 
Align Left (จัดชิดซาย) จัดขอความใหชิดซาย 

 
Center (กึ่งกลาง) จัดขอความใหอยูกลางบรรทัด 

 
Align Right (จัดชิดขวา) จัดขอความใหชิดขวา 

 
Justify (ชิดขอบ) จัดขอความใหเสมอกันทั้งซายและขวา 

 
Distributed (กระจาย) เหมือนชิดขอบ แตจะเพิ่มชองไฟ ระหวางอักษรและประโยค

ในภาษไทย เพื่อความสวยงาม 

 
Line Spacing   

(ระยะบรรทัด) 

ปรับระยะหางระหวางบรรทัด 

 
Numbering (ลําดับเลข) เติมหรือยกเลิกเลขลําดับหนาขอความ 

 
Bullets (สัญลักษณ

แสดงหัวขอยอย) 

เติมหรือยกเลิกจุดสีดํา(bullets) หรือสัญลักษณอื่น ๆ หนา 

ขอความ 

 
Decrease Indent 

(ลดการเยื้อง) 

รนทั้งยอหนาไปทางซาย 1 ขั้น 

 
Increase Indent  

(เพิ่มการเยื้อง) 

รนทั้งยอหนาไปทางขวา 1 ขั้น 

 
Outside Boder  

(เสนขอบนอก) 

ตีเสนหรือลงเสนที่ขอบดานตาง ๆ 

 
Highlight (เนน) เลือกแถบสีเพื่อเนนขอความ (เหมือนปากกสีสะทอนแสง) 

 
Font Color  

(สีแบบอักษร) 

เลือกสีของตัวอักษร 

 

 

 

 

 

 

 



แผนขอมูล (Work Sheet) 

 
 

 แผนขอมูล ใน Microsoft Excel จะประกอบดวย แผนขอมูลจํานวนหลายแผน ซึ่งสามารถ

คลิกเลือกไดจากแถบ Sheet1, Sheet2,… ตรงกรอบสีแดงในภาพ โดยสามารถเพิ่มแผนขอมูลไดมาก

ข้ึนและสามารถเปลี่ยนแผนขอมูลจากคําวา Sheet1 เปนชื่อที่เราตองการได ซึ่งแตละแผนขอมูลใน 1 

File ขอมูลสามารถเชื่อมโยงกนัไดดวย 

 
 
 
 
 
 
 
 
 



การเรียกชื่อของแตละ Cell 
 ตาราง 1 ชองใน Microsoft Excel เราจะเรียกวา 1 Cell โดยในแตละ 1 Cell จะมีชื่อเรียกที่

แตกตางกนั ซึง่ตําแหนงที่จะบอกถึงชื่อ Cell จะอยูตรงกรอบสีแดง ดังในรูป 

 
ชื่อ Cell นั้นจะมีความสําคญัเนื่องจากเราจะไวใชระบตุําแหนงที่ตองการคํานวณในแตละ Work Sheet 

 

การเลือกใชงาน Cell 
 ถาตองการทาํงาน Cell ใด ตองเลือก Cell นัน้เสียกอน โดยนําเมาสไปคลิกตําแหนง Cell ที่

ตองการ แตถาตองการทํางานกบัหลาย Cell มีวธิีการ ดังนี ้

1. ถาตองการเลอืก Cell ที่ติดกันใหเลื่อนเมาสไปยัง Cell เร่ิมตน กดเมาสคางไวแลวลากไปยัง

ตําแหนงที่ตองการ 

2. ถาตองการเลอืก Cell ที่ไมตดิกัน ใหกดปุม Ctrl บนแปนพิมพคางไว แลวนาํเมาสไปคลิกในแต

ละ Cell ที่ตองการในตําแหนงตางๆ ของโปรแกรม  

 

 

 



การพิมพขอมูลลงใน Cell 
1. คลิกเลือก Cell ที่ตองการพิมพขอมูล 

2. พิมพขอมูลลงไป โดยที่ขอมลูที่ตองการพมิพนัน้อาจเปนไดทั้งตวัเลขและตัวอักษร ในการ

เปลี่ยนภาษานั้นใหกดทีปุ่ม ~ หรือกดปุมเปลี่ยนภาษาบน Task Bar 

 
3. ขอมูลที่พิมพจะปรากฏใน Cell ที่เราพิมพลงไป พรอมๆ กับปรากฏในแถบสูตรดังรูป 

 
4. เมื่อพิมพขอมลูเรียบรอยแลวใหกดปุม Enter บนแปนพมิพ เคอรเซอรจะยายตําแหนงลงไปอยู

ในตําแหนงดานลางถัดลงไป 1 Cell 

 

 
 
 
 



การแกไขขอมูล 

มี 2 วธิีดังนี ้

1. คลิกเลือก Cell ที่ตองการเปลี่ยนขอมูล แลวพิมพขอมูลใหม จากนัน้กด Enter  

2. คลิกเลือก Cell ที่ตองการเปลี่ยนขอมูล > คลิกที่แถบสูตรเพื่อนําเคอรเซอรไวหลังขอความ  >

พิมพขอมูลใหม จากนัน้กด Enter  

• การแกไขขอมูลในแถบสูตรชวยใหสะดวกในการแกไขขอมูล ชวยลดความผิดพลาดใน

การแกไขขอมูล รวมถงึยงัสามารถแทรกตวัอักษรใน Cell นั้นๆไดดวย 

การลากขอมูลอัตโนมัติ 
 Microsoft Excel มีการสรางขอมูลเรียงลาํดับในกรณีทีม่ีการกรอกขอมูลเรียงลาํดับ เรียงกัน 2 

ลําดับ ใหเองอัตโนมัติเพื่อความสะดวกรวดเร็วในการทาํงานและลดความผิดพลาดของของมูล 

ขอมูลเรียงลําดับในทีน่ี้ยกตวัเอยางเชนตัวเลข, วนั, เดือน เปนตน ข้ันตอนมีดังนี ้

1. พิมพ หมายเลข 1 ที่ตําแหนง A1 แลวกด Enter  

2. พิมพ หมายเลข 2 ที่ตําแหนง A1 แลวกด Enter ดังภาพ  

 
3. คลิกที่ตําแหนง A1 กดเมาสคางไว แลวลากลงมาที่ตาํแหนง A2 แลวปลอยเมาส  

4. จะเกิดเสนสี่เหลี่ยมลอมรอบตําแหนง A1 และ A2 พรอมกันนี้ จะเหน็สี่เหลี่ยมเล็ก ๆ ทางมุมลาง

ดานขวามือ  

 
  

5. นําเคอรเซอรไปไวที่ ส่ีเหลี่ยมเล็ก ๆ มุมลางดานขวา เคอรเซอรจะเปลี่ยนเปนรูปกากบาท ดังภาพ  

 
  



 

6. กดเมาสคางไว แลวลากลงมาตรง ๆ จนถงึตําแหนง A6  

 
การยายตําแหนงขอมลู 

1. ลากแถบสวางใหครอบคลุมบริเวณที่ตองการ 
2. ใชเมาสคลิกทีข่อบ แลวลากไปยังตําแนงทีต่องการ 

 
 
การปรับขนาดความกวางของ คอรลัมน  

1. นําเมาสไปวางไวที่เสนขอบระหวาง cell  

2. เมาสจะเปลี่ยนเปนรูป  

3. กดเมาสคางไว แลวลากออกไปจนไดขนาดตามตองการ  

 
 
 
 
 
 



การตีเสน  
 การการจัดทําตาราง มักจะตองมีการตีเสน เชน ตีเสนตาราง ขีดเสนใตจํานวนเงิน ขีดเสน เปน

ตน การตีเสนขอบ มีวิธกีาร ดังนี ้ 

1. คลิกเลือก cell ที่ตองการ จากนัน้ลากแถบสวาง ใหครอบคลุมทุก cell ที่ตองการตีตาราง 

 
2. เลือกลักษณะเสนขอบที่ตองการ ให ไปที ่Toolbar คลิกทีส่ามเหลี่ยมเลก็ ๆ ขางไอคอน 

borders ดังรูป 

                     
  

3. คลิกเลือกเสนตาราง ดังรูป 

 
  

4. จะไดเสนตาราง ดังรูป 

 



การใสสีพื้นหลัง  
1. คลิกเลือกชองที่ตองการใสสีพื้นหลัง  

2. ไปที่แถบเครื่องมือ (Tool Bar) แลวคลิกที่ สีเติม  

3. คลิกเลือกสีตามตองการ  

 
  

4. จะไดสีพื้นหลงัขอความดงันี ้ 

 
การใชงานคําส่ังฟงกช่ัน  

ฟงกชั่นของ Excel ก็คือสูตรสําเร็จรูปที่โปรแกรมจัดทําไวใหแลว เพียงแตเราใสคาทีต่องการเขาไป

เทานัน้ หนาทีข่องฟงกชั่น กค็ือ เอาขอมูลที่เราใสเขาไป กระทาํการ บวก (+), ลบ (-), คูณ (*), หาร (/) 

กัน  

การใชฟงกชัน่ มีขอควรจํา ดงันี ้ 

• ข้ึนตนฟงกชัน่ ดวยเครื่องหมาย เทากับ (=) กอนทุกครั้ง 

• ตองระบุชื่อฟงกชั่น เชน SUM, IF, MAX เปนตน 

• คาที่ใสเขาฟงกชั่น ตองอยูในเครื่องหมายวงเล็บ  

• แตละคา ตองมีเครื่องหมายคอมมา(,)หรือ เครื่องหมายเซมิโคลอน(:)คั่น  

ตัวอยาง การเขียนฟงกชัน่ 

 =SUM (12, 22, A5, B1)  

 =MAX (E2:E4)              



คําส่ังในการใชสูตรคํานวณ 
1. ฟงกชัน Sum  

ความหมาย บวกจํานวนทั้งหมดในชวงของเซลล 

สูตร : Sum(number1,number2,….) 

2. ฟงกชัน Min 

ความหมาย สงกลับจํานวนที่นอยที่สุดในชุดของคาที่ระบุ 

สูตร : Min(number1,number2,….) 

3. ฟงกชัน Average  

ความหมาย สงกลับคาเฉลีย่ (คาเฉลี่ยเลขคณิต) ของอารกิวเมนตทัง้หมด 

สูตร : Average(number1,number2,….) 

4. ฟงกชัน Max 

ความหมาย สงกลับคาที่มากที่สุดในชุดของคาที่ระบ ุ

สูตร : Max(number1,number2,….) 

5. ฟงกชัน Count  

ความหมาย นบัจํานวนเซลลที่มีตัวเลขและจํานวนตวัเลขภายในรายการของอารกิวเมนต ให

ใช Count เพื่อหาจาํนวนของรายการขอมูลในเขตขอมูลตัวเลขภายในชวงหรืออารเรยของ

ตัวเลข 

สูตร : Count(value1,value2,…) 

6. ฟงกชัน Round  

ความหมาย ปดเศษจํานวนใหเปนจํานวนที่มีตําแหนงทศนิยมตามที่ระบุ 

สูตร : Round(number,num_digits) 

7. ฟงกชัน RANK 

การหาคาลําดบัที่ของตัวเลขที่ระบุ ซึง่อยูในรายการของตัวเลข ซึ่งสามารถใช ฟงกชนั Rank  

คาลําดับที่ข้ึนอยูกับคาของตัวเลขอื่นในรายการ (ถาคุณตองการจัดเรียงเอกสาร ลําดับที่ของ

ตัวเลขก็จะเทากับตําแหนง) 

สูตร : Rank(number,ref,order) 

 

 

 



ตัวอยางการคาํนวณหาผลรวมโดยใชฟงชัน่ Sum 

 
1. นําเมาสไปดับเบิ้ลคลิกที่ตําแหนง E5 

2. ใสสูตรการคํานวณ โดยสามารถทาํได 2 วธิีคือ 

 ใสสูตรลงในแถบสูตร ดังรูป 

 
เมื่อพิมพสูตรลงไปแลว กดปุม Enter บนแปนพิมพ 

 
 

 

 

 

 

 

 

 



 คํานวณโดยการกดปุม Function  เมื่อกดปุม  แลวจะปรากฏหนาตางแทรกฟงชั่น ดงัรูป

ดานลางขึ้นมา 

 
 

สวนตาง ๆ ของหนาจอที่ควรรูจัก ดังนี ้ 

1. ขอความสําหรบัคนหาฟงกชัน่ พิมพขอความที่ตองกระทํา เชน หาผลรวม หรือ add 

โปรแกรม จะนําฟงกชั่นที่เกีย่วกับการหาผลรวมมาแสดงใหเลือก  

2. เลือกประเภทของฟงกชั่น สวนนี้เปนทางเลือกสําหรับผูที่ไมชํานาญภาษาองักฤษ ไมรูวา

จะพิมพขอความใดตามขอ 1 ก็สามารถคลิกเลือก ประเภทไดจากทีน่ี ่ 

• Most Recently Used (ฟงกช่ันทีเ่พิง่ใชผานมา) 

• All (ฟงกชั่นทัง้หมด) 

• Financial (ฟงกชั่นเกี่ยวกับการเงนิ) 

• Math & Trig (ฟงกชั่นทางคณิตศาสตรและตรีโกณ) 

• Statistics (ฟงกชั่นทางสถิต)ิ 

3. แสดงรูปแบบของฟงกชั่นที่เลือก โดยเฉพาะจะตองใสคาอะไรบาง  

4. คําอธิบายฟงกชั่นที่เลือก  

5. เลือกฟงกข่ัน SUM แลวกด OK  



6. โปรแกรมจะเปดหนาจอการใชฟงกชัน่ SUM โดยใหโอกาสผูใช ในการคลิกเลือก ชอง cell 

ที่ตองการใหนาํมารวมกนั ดงัภาพ  

 
หนาจอนี้ และหนาจอการใชฟงกชั่นอืน่ ๆ มีลักษณะคลายกนั โดยหนาจอจะเปดโอกาสใหผูใช

เลือกคลิกชอง Cell จากใน Worksheet โดยตรง หนาจอนี้ มีสวนตาง ๆ ทีน่าสนใจ ดังนี ้ 

1. ขอมูลที่โปรแกรมเลือกให จากภาพ จะเหน็วา โปรแกรมเดาเอาไวกอนวาเราตองการนําคา

ขางบนมารวมกัน จึงระบุเปนขอมูลที่อยูตาํแหนง E2:E4  

2. ถาเราตองการเปลี่ยนคาที่โปรแกรมเลือก ใหคลิกทีน่ี ่ เพือ่จะไปเปด Worksheet และผูใช

สามารถใชเมาสคลิกเลือกได  

7. ในกรณีนี ้ขอมูลถูกตองแลว ใหคลิก OK  

8. จะไดผลรวม ดังภาพ  

 
 

 

 

 

 



การสรางแผนภูม ิ
 
 โปรแกรม Microsoft Excel สามารถแปลงขอมูลตัวเลขตาง ๆ ในตาราง ใหอยูในรูปแผนภูมิ

แบบตาง ๆ ได ดังนี ้
การสรางกราฟแทง  
วิธีการสราง มดีังนี ้ 

1. เปดไฟล Excel ใหม และพิมพขอมูลใหเหมือนในภาพขางลางนี ้ 

 
  

2. ลากแถบสวาง ตั้งแต A3 ถึง D6 เพื่อกาํหนดขอบเขตของขอมูลที่จะนําไปทําแผนภูมิ  

 
  

3. คลิก ไอคอน รูป บนแถบเครื่องมือ หรือ ไปที่เมนู Insert > Chart ... จะปรากฏหนาตาง 

ตัวชวยสรางแผนภูม ิดังรูป 

 



 
4. เลือกประเภทของแผนภูมิ และรูปแบบของแผนภูม ิแลวคลิกปุม Next เพื่อไปหนาจอตอไป  

5. จากนั้นจะปรากฏหนาตาง เพื่อกาํหนดขอบเขตของขอมูล เนื่องจากเราได ลากแถบสวาง

กําหนดขอบเขตไวแลว จึงเปนขอมูลทีถู่กตองแลว ใหคลิกปุม Next  

 



  

6. จะปรากฏหนาตางตวัชวยสรางแผนภูม ิ กาํหนดรายละเอียดของแผนภูมิ เชน ชื่อแผนภูมิ ชื่อ

แกนตามแนวนอน และชื่อแกนตามแนวตัง้ เปนตน  

 
  

7. เราตองการใหแผนภูมิ แสดงขอมูลเปนตัวเลขอยูในตารางใตภาพแผนภูมิ ใหคลิกที่แถบ 

ตารางขอมูลและคลิก ที่แสดงตารางขอมูล 

 



  

8. จะไดแผนภูมิแบบแทง ตามตองการ ถาภาพตองการเพิ่มหรือลดขนาดของแผนภมูิใหนาํเมาส 
ไปไวที่ปุมดําทีเ่สนกรอบ เมื่อเมาส เปลีย่นเปนรูปลูกศรสองทาง ดงัภาพ ใหกดคางไว แลวลาก

ขยายออกหรือลดขนาด เมื่อไดขนาดที่ตองการแลวปลอยเมาส  

 
  

การสรางกราฟวงกลม  
การสรางกราฟวงกลม ก็ทําเชนเดียวกับการสรางกราฟแทง  

ขอระวัง  

การแสดงขอมลูของกราฟวงกลม จะมีขอมูลเพียง 2 มิติ เทานั้น เชน จะแสดงกราฟภายใน

กราฟวงกลมเดียวกนั ไมได ตองแยกแสดงเปนรายเดือน และถาจะแสดงทั้ง 3 เดือน ตองแสดงถึง 3 

กราฟ หรืออาจจะรวมขอมูลทั้ง 3 เดือนเขาดวยกนั แลวแสดงเปนกราฟเดียว ก็ได  

1. จากขอมูลเดิม ใหลากแถบสวางบริเวณขอมูลที่จะนํามาทําเปนกราฟวงกลม คือบริเวณ 

A3:B7 ดังรูป 

 
  



2. คลิก ไอคอน รูป บนแถบเครื่องมือ หรือ ไปที่เมนู Insert > Chart ... จะปรากฏหนาตาง 

ตัวชวยสรางแผนภูม ิดังรูป 

 

 
3. คลิกเลือก ประเภทกราฟวงกลม หรือ Pie  

 
  

4. ถาไมตองการตกแตงเพิ่มเตมิ ใหคลิกปุม Finish จะไดกราฟรูปวงกลม ตามตองการ  

 



  

การแตงกราฟวงกลม  
1. ใชเมาสชีท้ี่สวนของ เสื้อ 

 
  

2. คลิก 1 คร้ัง วงกลมจะถกูเลือก  

 
  

3. คลิกอีก 1 คร้ัง สวนของเสื้อ จะถูกเลือก  

 
  



4. ใหกดเมาสอีกครั้ง คราวนี้กดคางไว แลวลากออกมา ชิน้สวนของตุกตาหม ีจะถูกแยกออกมา 

ดังภาพ  

 
การส่ังพิมพ  
 คลิกที่ภาพ  บน Toolbar กอนที่จะสั่งพิมพจริง ควรขอดู Print Preview เพื่อตรวจสอบวา 

ส่ิงที่จะพิมพ อยูในหนาที่ตองการและมีรูปแบบที่จะนําเสนอทีพ่อใจ  

การตรวจสอบกอนพิมพ  
1. ไปที่เมน ูFile > Print Preview เมื่อเปดเมนู ดังรูป 

 
 

 



2. เมื่อกดตัวอยางกอนพิมพจะปรากฏหนาตางดังรูป 

 
การกําหนดใหพิมพตามแนวตั้ง หรือตามแนวนอน  

Print Preview > กดปุม ติดตั้ง  เลือกแถบ Page และ คลิกเลือก แนวนอน ดังภาพ  

 
 



การกําหนดความกวางของคอลัมน  

ไปที่ Print Preview > กดปุม ระยะขอบ  จะประกฎเสนแบงระยะขอบสําหรับปรับ คอรลัมน 

ให นาํเมาส ไปไวที่จุดสี่เหลีย่มสีดําดานบนเมาสจะเปลีย่นเปนรูปดังภาพ > กดเมาสคางไว แลวเลื่อน

เขาหรือออก เพื่อปรับลดหรือขยายเสนระยะขอบ เมื่อไดระยะทีพ่อใจแลวปลอยเมาส 

 
 

การพิมพหัวกระดาษ ทายกระดาษ  

Print Preview โดยกดปุม  แลวเลือกแถบ หัวกระดาษ/ทายกระดาษ จากนัน้จะ

ปรากฏหนาตางดังรูป 

 
 



1. คลิกปุม 1 เพือ่เลือกขอความสําหรับพิมพหัวกระดาษ  

2. คลิกปุม 2 เพือ่เลือกขอความสําหรับพิมพทายกระดาษ  

3. คลิกปุม 3 เพือ่เลือกขอความสําหรับพิมพหัวกระดาษแบบอื่น ๆ  

4. คลิกปุม 4 เพือ่เลือกขอความสําหรับพิมพทายกระดาษแบบอื่น ๆ  

 
ลําดับการพมิพ  
1. คลิก แฟม > ตัวอยางกอนพิมพ 

2. คลิกเลือกปุม  แลวเลือกแถบแผนงาน  

 
3. สวน ลําดับของหนาใหคลิกเลือก ลําดับการพิมพที่ตองการ  

 


